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Microsoft Excel 
 คือโปรแกรมที่เหมาะกับงานดานการคํานวณ การตีตาราง การหาคาสตูรตางๆ การสรางกราฟ 

โดยที่เมื่อเปล่ียนแปลงตวัเลขใดๆ โปรแกรมจะทาํการคํานวณสูตรที่เชือ่มโยงกับตัวเลขนั้นๆใหอัตโนมัติ 

ในการทํางานของโปรแกรมจะใชตารางตามแนวตั้ง (columns) และแนวนอน (rows) เปนหลัก  

 

การเรียกใชโปรแกรม Microsoft Excel 

 
 
เลือกที่ 1. Start > 2. All Programs > 3. Microsoft Office > 4. Microsoft Office Excel 2003 

 

 

 

 



หนาตาโปรแกรม 

 
 

1. แถบชื่อเร่ือง (Title Bar) ชื่อโปรแกรมและชื่อไฟล 

2. แถบเมน ู(Menu Bar) ชื่อเมนูที่เรียกใชได 

3. แถบเครื่องมือ (Tool Bar) แสดงคําสั่งที่ใชงานบอย ๆ แสดงในรูปของรูปภาพ (icon) 

4. แถบสูตร (Formula Bar) สําหรับใสสูตรเพือ่คํานวณ และแสดงเนื้อหาขอมูลในแตละ Cell 

5. เร่ิมตน (Getting Started) หนาตางอํานวยความสะดวกในการเริ่มตนใชงานโปรแกรม 

6. แถบสถานะ (Status Bar) แสดงการใชงานเอกสารในขณะนั้น 

 

 

 

 

 

 

 



แถบเครื่องมือมาตรฐาน (Standard) 

 
 

ปุม ช่ือปุม หนาที ่

 
New (สราง) เปดเอกสารชุดใหม 

 
Open (เปด) เรียกเอกสารชุดเกาที่เก็บบันทึกไวมาใช 

 
Save (บันทึก) ส่ังเก็บบันทึกเอกสาร 

 
Permission (สิทธิ) การจัดการสิทธิ์ในการใชขอมูล 

 

 

E-mail 

(as Attachment) 

(อีเมล(ตามใบแนบ)) 

เปดโปแกรมสรางอีเมล พรอมแนบไฟลของ Word ไปดวย 

 
Print (พิมพ) ส่ังพิมพเอกสารลงบนกระดาษ 

 
Print Preview  

(ตัวอยางกอนพิมพ) 

แสดงผลการพิมพบนหนาจอเพื่อดูกอนพิมพจริง 

 
Spelling (การสะกด) ตรวจสอบการสะกดคําตามพจนนุกรม 

 
Research (การวิจัย) ใหขอมูลอางอิงสําหรับงานวิจัย 

 
Cut (ตัด) ลบขอความหรือออบเจ็คที่เลือกไวไปไวในคลิปบอรด 

 
Copy (คัดลอก) คัดลอกขอความหรือออบเจ็คที่เลือกไวไปไวในคลิปบอรด 

 
Past (วาง) นําขอความหรือออบเจ็คมาวางในเอกสารตรงที่ตองการ 

 
Format Painter  

(ตัวคัดวางรูปแบบ) 

คัดลอกรูปแบบขอความหนึ่งไปใสใหกับอีกขอความ 

 
Undo (เลิกทํา) ยกเลิกคําส่ังหรือการทํางานที่ทําลาสุด 

 
Redo (ทําอีกครั้ง) เรียกทําคําส่ังหรือการทํางานที่ถูกยกเลิกไป 

 
Hyperlink  

(การเชื่อมโยงหลายมิติ) 

สรางการเชื่อมโยงจากตําแหนง ที่กําหนดไวไปยังเอกสาร หรือไป

ยังสวนอื่นในเอกสารเดียวกัน หรือURL 

 
Table & Border (ตาราง

และเสนขอบ) 

แสดง/ไมแสดงแถบเครื่องมือตารางและเสนขอบ 

 
Insert Table  

(แทรกตาราง) 

ใสตารางในเอกสาร 



ปุม ช่ือปุม หนาที ่

 
Insert Microsoft Excel 

Worksheet (แทรกแผน 

งาน) 

แทรกสเปรดชีทของโปรแกรม Microsoft Excel 

 
Columns (คอลัมน) จัดขอความเปนหลายคอลัมนเหมือนหนังสือพิมพ 

 

 
Drawing (รูปวาด) เปด/ปด แถบเครื่องมือรูปวาด 

 
Document Map  

(แมปเอกสาร) 

เปด/ปด แผนที่เอกสาร 

 
Show/Hide (ซอน/แสดง) ซอนหรือแสดงสัญลักษณพิเศษ ซึ่งจะไมถูกพิมพออกมา 

 
Zoom (ยอย/ขยาย) ยอหรือขยายเอกสารที่แสดงบนหนาจอตามเปอรเซ็นตที่เลือก 

 
Office Assistant  

(วิธีใช Microsoft Word) 

แสดงOfficeAssistant ซึ่งเปนตัวการตูนที่ใหคําแนะนําในการใช

งาน 

 
Read  

(มุมมองเคาโครงการอาน) 

เปล่ียนเคาโครงของหนากระดาษ และปรับปรุงการแสดงผลของ

ตัวอักษรเพื่อทําใหผานขอมูลไดสะดวกขึ้น เหมาะกับ 

หนากระดาษ ที่มีขอความยาวๆ แตจะไมเหมาะกับพวกกราฟก 

หรือตาราง 

 
แถบเครื่องมือ จัดรูปแบบ (Formatting) 

 
 

ปุม ช่ือปุม หนาที ่

 
Styles and Format 

(ลักษณะและรูปแบบ) 

เปดทาสกเพน (Styles and Formatting) 

 
Style (ลักษณะ) แสดงหรือใชเลือก Style (รูปแบบ) ของขอความตรงที่ 

เคอรเซอรอยู 

 
Font (แบบอักษร) แสดงหรือเลือกแบบของตัวอักษรตรงที่เคอรเซอรอยู 

 
Font Size  

(ขนาดแบบอักษร)   

แสดงหรือใชเลือกขนาดของตัวอักษรที่เคอรเซอรอยู 

 

 
Bold (ตัวหนา) ทําเปนตัวหนาหรือยกเลิก 



ปุม ช่ือปุม หนาที่ 

 
Italic (ตัวเอียง) ทําเปนตัวเอียงหรือยกเลิก 

 
Underline (ขีดเสนใต) ขีดเสนใตหรือยกเลิก 

 
Align Left (จัดชิดซาย) จัดขอความใหชิดซาย 

 
Center (กึ่งกลาง) จัดขอความใหอยูกลางบรรทัด 

 
Align Right (จัดชิดขวา) จัดขอความใหชิดขวา 

 
Justify (ชิดขอบ) จัดขอความใหเสมอกันทั้งซายและขวา 

 
Distributed (กระจาย) เหมือนชิดขอบ แตจะเพิ่มชองไฟ ระหวางอักษรและประโยค

ในภาษไทย เพื่อความสวยงาม 

 
Line Spacing   

(ระยะบรรทัด) 

ปรับระยะหางระหวางบรรทัด 

 
Numbering (ลําดับเลข) เติมหรือยกเลิกเลขลําดับหนาขอความ 

 
Bullets (สัญลักษณ

แสดงหัวขอยอย) 

เติมหรือยกเลิกจุดสีดํา(bullets) หรือสัญลักษณอื่น ๆ หนา 

ขอความ 

 
Decrease Indent 

(ลดการเยื้อง) 

รนทั้งยอหนาไปทางซาย 1 ขั้น 

 
Increase Indent  

(เพิ่มการเยื้อง) 

รนทั้งยอหนาไปทางขวา 1 ขั้น 

 
Outside Boder  

(เสนขอบนอก) 

ตีเสนหรือลงเสนที่ขอบดานตาง ๆ 

 
Highlight (เนน) เลือกแถบสีเพื่อเนนขอความ (เหมือนปากกสีสะทอนแสง) 

 
Font Color  

(สีแบบอักษร) 

เลือกสีของตัวอักษร 

 

 

 

 

 

 

 



แผนขอมูล (Work Sheet) 

 
 

 แผนขอมูล ใน Microsoft Excel จะประกอบดวย แผนขอมูลจํานวนหลายแผน ซึ่งสามารถ

คลิกเลือกไดจากแถบ Sheet1, Sheet2,… ตรงกรอบสีแดงในภาพ โดยสามารถเพิ่มแผนขอมูลไดมาก

ข้ึนและสามารถเปลี่ยนแผนขอมูลจากคําวา Sheet1 เปนชื่อที่เราตองการได ซึ่งแตละแผนขอมูลใน 1 

File ขอมูลสามารถเชื่อมโยงกนัไดดวย 

 
 
 
 
 
 
 
 
 



การเรียกชื่อของแตละ Cell 
 ตาราง 1 ชองใน Microsoft Excel เราจะเรียกวา 1 Cell โดยในแตละ 1 Cell จะมีชื่อเรียกที่

แตกตางกนั ซึง่ตําแหนงที่จะบอกถึงชื่อ Cell จะอยูตรงกรอบสีแดง ดังในรูป 

 
ชื่อ Cell นั้นจะมีความสําคญัเนื่องจากเราจะไวใชระบตุําแหนงที่ตองการคํานวณในแตละ Work Sheet 

 

การเลือกใชงาน Cell 
 ถาตองการทาํงาน Cell ใด ตองเลือก Cell นัน้เสียกอน โดยนําเมาสไปคลิกตําแหนง Cell ที่

ตองการ แตถาตองการทํางานกบัหลาย Cell มีวธิีการ ดังนี ้

1. ถาตองการเลอืก Cell ที่ติดกันใหเลื่อนเมาสไปยัง Cell เร่ิมตน กดเมาสคางไวแลวลากไปยัง

ตําแหนงที่ตองการ 

2. ถาตองการเลอืก Cell ที่ไมตดิกัน ใหกดปุม Ctrl บนแปนพิมพคางไว แลวนาํเมาสไปคลิกในแต

ละ Cell ที่ตองการในตําแหนงตางๆ ของโปรแกรม  

 

 

 



การพิมพขอมูลลงใน Cell 
1. คลิกเลือก Cell ที่ตองการพิมพขอมูล 

2. พิมพขอมูลลงไป โดยที่ขอมลูที่ตองการพมิพนัน้อาจเปนไดทั้งตวัเลขและตัวอักษร ในการ

เปลี่ยนภาษานั้นใหกดทีปุ่ม ~ หรือกดปุมเปลี่ยนภาษาบน Task Bar 

 
3. ขอมูลที่พิมพจะปรากฏใน Cell ที่เราพิมพลงไป พรอมๆ กับปรากฏในแถบสูตรดังรูป 

 
4. เมื่อพิมพขอมลูเรียบรอยแลวใหกดปุม Enter บนแปนพมิพ เคอรเซอรจะยายตําแหนงลงไปอยู

ในตําแหนงดานลางถัดลงไป 1 Cell 

 

 
 
 
 



การแกไขขอมูล 

มี 2 วธิีดังนี ้

1. คลิกเลือก Cell ที่ตองการเปลี่ยนขอมูล แลวพิมพขอมูลใหม จากนัน้กด Enter  

2. คลิกเลือก Cell ที่ตองการเปลี่ยนขอมูล > คลิกที่แถบสูตรเพื่อนําเคอรเซอรไวหลังขอความ  >

พิมพขอมูลใหม จากนัน้กด Enter  

• การแกไขขอมูลในแถบสูตรชวยใหสะดวกในการแกไขขอมูล ชวยลดความผิดพลาดใน

การแกไขขอมูล รวมถงึยงัสามารถแทรกตวัอักษรใน Cell นั้นๆไดดวย 

การลากขอมูลอัตโนมัติ 
 Microsoft Excel มีการสรางขอมูลเรียงลาํดับในกรณีทีม่ีการกรอกขอมูลเรียงลาํดับ เรียงกัน 2 

ลําดับ ใหเองอัตโนมัติเพื่อความสะดวกรวดเร็วในการทาํงานและลดความผิดพลาดของของมูล 

ขอมูลเรียงลําดับในทีน่ี้ยกตวัเอยางเชนตัวเลข, วนั, เดือน เปนตน ข้ันตอนมีดังนี ้

1. พิมพ หมายเลข 1 ที่ตําแหนง A1 แลวกด Enter  

2. พิมพ หมายเลข 2 ที่ตําแหนง A1 แลวกด Enter ดังภาพ  

 
3. คลิกที่ตําแหนง A1 กดเมาสคางไว แลวลากลงมาที่ตาํแหนง A2 แลวปลอยเมาส  

4. จะเกิดเสนสี่เหลี่ยมลอมรอบตําแหนง A1 และ A2 พรอมกันนี้ จะเหน็สี่เหลี่ยมเล็ก ๆ ทางมุมลาง

ดานขวามือ  

 
  

5. นําเคอรเซอรไปไวที่ ส่ีเหลี่ยมเล็ก ๆ มุมลางดานขวา เคอรเซอรจะเปลี่ยนเปนรูปกากบาท ดังภาพ  

 
  



 

6. กดเมาสคางไว แลวลากลงมาตรง ๆ จนถงึตําแหนง A6  

 
การยายตําแหนงขอมลู 

1. ลากแถบสวางใหครอบคลุมบริเวณที่ตองการ 
2. ใชเมาสคลิกทีข่อบ แลวลากไปยังตําแนงทีต่องการ 

 
 
การปรับขนาดความกวางของ คอรลัมน  

1. นําเมาสไปวางไวที่เสนขอบระหวาง cell  

2. เมาสจะเปลี่ยนเปนรูป  

3. กดเมาสคางไว แลวลากออกไปจนไดขนาดตามตองการ  

 
 
 
 
 
 



การตีเสน  
 การการจัดทําตาราง มักจะตองมีการตีเสน เชน ตีเสนตาราง ขีดเสนใตจํานวนเงิน ขีดเสน เปน

ตน การตีเสนขอบ มีวิธกีาร ดังนี ้ 

1. คลิกเลือก cell ที่ตองการ จากนัน้ลากแถบสวาง ใหครอบคลุมทุก cell ที่ตองการตีตาราง 

 
2. เลือกลักษณะเสนขอบที่ตองการ ให ไปที ่Toolbar คลิกทีส่ามเหลี่ยมเลก็ ๆ ขางไอคอน 

borders ดังรูป 

                     
  

3. คลิกเลือกเสนตาราง ดังรูป 

 
  

4. จะไดเสนตาราง ดังรูป 

 



การใสสีพื้นหลัง  
1. คลิกเลือกชองที่ตองการใสสีพื้นหลัง  

2. ไปที่แถบเครื่องมือ (Tool Bar) แลวคลิกที่ สีเติม  

3. คลิกเลือกสีตามตองการ  

 
  

4. จะไดสีพื้นหลงัขอความดงันี ้ 

 
การใชงานคําส่ังฟงกช่ัน  

ฟงกชั่นของ Excel ก็คือสูตรสําเร็จรูปที่โปรแกรมจัดทําไวใหแลว เพียงแตเราใสคาทีต่องการเขาไป

เทานัน้ หนาทีข่องฟงกชั่น กค็ือ เอาขอมูลที่เราใสเขาไป กระทาํการ บวก (+), ลบ (-), คูณ (*), หาร (/) 

กัน  

การใชฟงกชัน่ มีขอควรจํา ดงันี ้ 

• ข้ึนตนฟงกชัน่ ดวยเครื่องหมาย เทากับ (=) กอนทุกครั้ง 

• ตองระบุชื่อฟงกชั่น เชน SUM, IF, MAX เปนตน 

• คาที่ใสเขาฟงกชั่น ตองอยูในเครื่องหมายวงเล็บ  

• แตละคา ตองมีเครื่องหมายคอมมา(,)หรือ เครื่องหมายเซมิโคลอน(:)คั่น  

ตัวอยาง การเขียนฟงกชัน่ 

 =SUM (12, 22, A5, B1)  

 =MAX (E2:E4)              



คําส่ังในการใชสูตรคํานวณ 
1. ฟงกชัน Sum  

ความหมาย บวกจํานวนทั้งหมดในชวงของเซลล 

สูตร : Sum(number1,number2,….) 

2. ฟงกชัน Min 

ความหมาย สงกลับจํานวนที่นอยที่สุดในชุดของคาที่ระบุ 

สูตร : Min(number1,number2,….) 

3. ฟงกชัน Average  

ความหมาย สงกลับคาเฉลีย่ (คาเฉลี่ยเลขคณิต) ของอารกิวเมนตทัง้หมด 

สูตร : Average(number1,number2,….) 

4. ฟงกชัน Max 

ความหมาย สงกลับคาที่มากที่สุดในชุดของคาที่ระบ ุ

สูตร : Max(number1,number2,….) 

5. ฟงกชัน Count  

ความหมาย นบัจํานวนเซลลที่มีตัวเลขและจํานวนตวัเลขภายในรายการของอารกิวเมนต ให

ใช Count เพื่อหาจาํนวนของรายการขอมูลในเขตขอมูลตัวเลขภายในชวงหรืออารเรยของ

ตัวเลข 

สูตร : Count(value1,value2,…) 

6. ฟงกชัน Round  

ความหมาย ปดเศษจํานวนใหเปนจํานวนที่มีตําแหนงทศนิยมตามที่ระบุ 

สูตร : Round(number,num_digits) 

7. ฟงกชัน RANK 

การหาคาลําดบัที่ของตัวเลขที่ระบุ ซึง่อยูในรายการของตัวเลข ซึ่งสามารถใช ฟงกชนั Rank  

คาลําดับที่ข้ึนอยูกับคาของตัวเลขอื่นในรายการ (ถาคุณตองการจัดเรียงเอกสาร ลําดับที่ของ

ตัวเลขก็จะเทากับตําแหนง) 

สูตร : Rank(number,ref,order) 

 

 

 



ตัวอยางการคาํนวณหาผลรวมโดยใชฟงชัน่ Sum 

 
1. นําเมาสไปดับเบิ้ลคลิกที่ตําแหนง E5 

2. ใสสูตรการคํานวณ โดยสามารถทาํได 2 วธิีคือ 

 ใสสูตรลงในแถบสูตร ดังรูป 

 
เมื่อพิมพสูตรลงไปแลว กดปุม Enter บนแปนพิมพ 

 
 

 

 

 

 

 

 

 



 คํานวณโดยการกดปุม Function  เมื่อกดปุม  แลวจะปรากฏหนาตางแทรกฟงชั่น ดงัรูป

ดานลางขึ้นมา 

 
 

สวนตาง ๆ ของหนาจอที่ควรรูจัก ดังนี ้ 

1. ขอความสําหรบัคนหาฟงกชัน่ พิมพขอความที่ตองกระทํา เชน หาผลรวม หรือ add 

โปรแกรม จะนําฟงกชั่นที่เกีย่วกับการหาผลรวมมาแสดงใหเลือก  

2. เลือกประเภทของฟงกชั่น สวนนี้เปนทางเลือกสําหรับผูที่ไมชํานาญภาษาองักฤษ ไมรูวา

จะพิมพขอความใดตามขอ 1 ก็สามารถคลิกเลือก ประเภทไดจากทีน่ี ่ 

• Most Recently Used (ฟงกช่ันทีเ่พิง่ใชผานมา) 

• All (ฟงกชั่นทัง้หมด) 

• Financial (ฟงกชั่นเกี่ยวกับการเงนิ) 

• Math & Trig (ฟงกชั่นทางคณิตศาสตรและตรีโกณ) 

• Statistics (ฟงกชั่นทางสถิต)ิ 

3. แสดงรูปแบบของฟงกชั่นที่เลือก โดยเฉพาะจะตองใสคาอะไรบาง  

4. คําอธิบายฟงกชั่นที่เลือก  

5. เลือกฟงกข่ัน SUM แลวกด OK  



6. โปรแกรมจะเปดหนาจอการใชฟงกชัน่ SUM โดยใหโอกาสผูใช ในการคลิกเลือก ชอง cell 

ที่ตองการใหนาํมารวมกนั ดงัภาพ  

 
หนาจอนี้ และหนาจอการใชฟงกชั่นอืน่ ๆ มีลักษณะคลายกนั โดยหนาจอจะเปดโอกาสใหผูใช

เลือกคลิกชอง Cell จากใน Worksheet โดยตรง หนาจอนี้ มีสวนตาง ๆ ทีน่าสนใจ ดังนี ้ 

1. ขอมูลที่โปรแกรมเลือกให จากภาพ จะเหน็วา โปรแกรมเดาเอาไวกอนวาเราตองการนําคา

ขางบนมารวมกัน จึงระบุเปนขอมูลที่อยูตาํแหนง E2:E4  

2. ถาเราตองการเปลี่ยนคาที่โปรแกรมเลือก ใหคลิกทีน่ี ่ เพือ่จะไปเปด Worksheet และผูใช

สามารถใชเมาสคลิกเลือกได  

7. ในกรณีนี ้ขอมูลถูกตองแลว ใหคลิก OK  

8. จะไดผลรวม ดังภาพ  

 
 

 

 

 

 



การสรางแผนภูม ิ
 
 โปรแกรม Microsoft Excel สามารถแปลงขอมูลตัวเลขตาง ๆ ในตาราง ใหอยูในรูปแผนภูมิ

แบบตาง ๆ ได ดังนี ้
การสรางกราฟแทง  
วิธีการสราง มดีังนี ้ 

1. เปดไฟล Excel ใหม และพิมพขอมูลใหเหมือนในภาพขางลางนี ้ 

 
  

2. ลากแถบสวาง ตั้งแต A3 ถึง D6 เพื่อกาํหนดขอบเขตของขอมูลที่จะนําไปทําแผนภูมิ  

 
  

3. คลิก ไอคอน รูป บนแถบเครื่องมือ หรือ ไปที่เมนู Insert > Chart ... จะปรากฏหนาตาง 

ตัวชวยสรางแผนภูม ิดังรูป 

 



 
4. เลือกประเภทของแผนภูมิ และรูปแบบของแผนภูม ิแลวคลิกปุม Next เพื่อไปหนาจอตอไป  

5. จากนั้นจะปรากฏหนาตาง เพื่อกาํหนดขอบเขตของขอมูล เนื่องจากเราได ลากแถบสวาง

กําหนดขอบเขตไวแลว จึงเปนขอมูลทีถู่กตองแลว ใหคลิกปุม Next  

 



  

6. จะปรากฏหนาตางตวัชวยสรางแผนภูม ิ กาํหนดรายละเอียดของแผนภูมิ เชน ชื่อแผนภูมิ ชื่อ

แกนตามแนวนอน และชื่อแกนตามแนวตัง้ เปนตน  

 
  

7. เราตองการใหแผนภูมิ แสดงขอมูลเปนตัวเลขอยูในตารางใตภาพแผนภูมิ ใหคลิกที่แถบ 

ตารางขอมูลและคลิก ที่แสดงตารางขอมูล 

 



  

8. จะไดแผนภูมิแบบแทง ตามตองการ ถาภาพตองการเพิ่มหรือลดขนาดของแผนภมูิใหนาํเมาส 
ไปไวที่ปุมดําทีเ่สนกรอบ เมื่อเมาส เปลีย่นเปนรูปลูกศรสองทาง ดงัภาพ ใหกดคางไว แลวลาก

ขยายออกหรือลดขนาด เมื่อไดขนาดที่ตองการแลวปลอยเมาส  

 
  

การสรางกราฟวงกลม  
การสรางกราฟวงกลม ก็ทําเชนเดียวกับการสรางกราฟแทง  

ขอระวัง  

การแสดงขอมลูของกราฟวงกลม จะมีขอมูลเพียง 2 มิติ เทานั้น เชน จะแสดงกราฟภายใน

กราฟวงกลมเดียวกนั ไมได ตองแยกแสดงเปนรายเดือน และถาจะแสดงทั้ง 3 เดือน ตองแสดงถึง 3 

กราฟ หรืออาจจะรวมขอมูลทั้ง 3 เดือนเขาดวยกนั แลวแสดงเปนกราฟเดียว ก็ได  

1. จากขอมูลเดิม ใหลากแถบสวางบริเวณขอมูลที่จะนํามาทําเปนกราฟวงกลม คือบริเวณ 

A3:B7 ดังรูป 

 
  



2. คลิก ไอคอน รูป บนแถบเครื่องมือ หรือ ไปที่เมนู Insert > Chart ... จะปรากฏหนาตาง 

ตัวชวยสรางแผนภูม ิดังรูป 

 

 
3. คลิกเลือก ประเภทกราฟวงกลม หรือ Pie  

 
  

4. ถาไมตองการตกแตงเพิ่มเตมิ ใหคลิกปุม Finish จะไดกราฟรูปวงกลม ตามตองการ  

 



  

การแตงกราฟวงกลม  
1. ใชเมาสชีท้ี่สวนของ เสื้อ 

 
  

2. คลิก 1 คร้ัง วงกลมจะถกูเลือก  

 
  

3. คลิกอีก 1 คร้ัง สวนของเสื้อ จะถูกเลือก  

 
  



4. ใหกดเมาสอีกครั้ง คราวนี้กดคางไว แลวลากออกมา ชิน้สวนของตุกตาหม ีจะถูกแยกออกมา 

ดังภาพ  

 
การส่ังพิมพ  
 คลิกที่ภาพ  บน Toolbar กอนที่จะสั่งพิมพจริง ควรขอดู Print Preview เพื่อตรวจสอบวา 

ส่ิงที่จะพิมพ อยูในหนาที่ตองการและมีรูปแบบที่จะนําเสนอทีพ่อใจ  

การตรวจสอบกอนพิมพ  
1. ไปที่เมน ูFile > Print Preview เมื่อเปดเมนู ดังรูป 

 
 

 



2. เมื่อกดตัวอยางกอนพิมพจะปรากฏหนาตางดังรูป 

 
การกําหนดใหพิมพตามแนวตั้ง หรือตามแนวนอน  

Print Preview > กดปุม ติดตั้ง  เลือกแถบ Page และ คลิกเลือก แนวนอน ดังภาพ  

 
 



การกําหนดความกวางของคอลัมน  

ไปที่ Print Preview > กดปุม ระยะขอบ  จะประกฎเสนแบงระยะขอบสําหรับปรับ คอรลัมน 

ให นาํเมาส ไปไวที่จุดสี่เหลีย่มสีดําดานบนเมาสจะเปลีย่นเปนรูปดังภาพ > กดเมาสคางไว แลวเลื่อน

เขาหรือออก เพื่อปรับลดหรือขยายเสนระยะขอบ เมื่อไดระยะทีพ่อใจแลวปลอยเมาส 

 
 

การพิมพหัวกระดาษ ทายกระดาษ  

Print Preview โดยกดปุม  แลวเลือกแถบ หัวกระดาษ/ทายกระดาษ จากนัน้จะ

ปรากฏหนาตางดังรูป 

 
 



1. คลิกปุม 1 เพือ่เลือกขอความสําหรับพิมพหัวกระดาษ  

2. คลิกปุม 2 เพือ่เลือกขอความสําหรับพิมพทายกระดาษ  

3. คลิกปุม 3 เพือ่เลือกขอความสําหรับพิมพหัวกระดาษแบบอื่น ๆ  

4. คลิกปุม 4 เพือ่เลือกขอความสําหรับพิมพทายกระดาษแบบอื่น ๆ  

 
ลําดับการพมิพ  
1. คลิก แฟม > ตัวอยางกอนพิมพ 

2. คลิกเลือกปุม  แลวเลือกแถบแผนงาน  

 
3. สวน ลําดับของหนาใหคลิกเลือก ลําดับการพิมพที่ตองการ  

 


